
CHAPTER 5

Fundamental Operating Systems

Objectives

Upon completion of this chapter, you should be able
to answer the following questions:

n What is the purpose of an operating system?

n How do different operating systems compare
with one another based on purpose, limitations,
and compatibilities?

n How do you determine the appropriate operating
system based on customer needs?

n How do you install an operating system?

n How do you navigate within an operating system
GUI?

n What are some common preventive maintenance
techniques for operating systems and how are
they applied?

n What can be done to troubleshoot operating 
systems?

Key Terms
This chapter uses the following key terms. You can find the definitions in the Glossary.
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File Allocation Table, 32-bit (FAT32) page 132

New Technology File System (NTFS) page 132

disk cloning page 139
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Msconfig page 143

Regedit page 143

Msinfo32 page 144

Dxdiag page 144
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The operating system (OS) controls almost all functions on a computer. In this chapter, you
will learn about the components, functions, and terminology related to the Windows 2000,
Windows XP, Windows Vista, and Windows 7 operating systems.

After completing this chapter, you will meet these objectives:

n Explain the purpose of an operating system.

n Describe and compare operating systems to include purpose, limitations, and compati-
bilities.

n Determine the operating system based on customer needs.

n Install an operating system.

n Navigate a graphical user interface (GUI).

n Identify and apply common preventive maintenance techniques for operating systems.

n Troubleshoot operating systems.

Explain the Purpose of an Operating System
All computers rely on an Operating System (OS) to provide the interface for interaction
between users, applications, and hardware. The OS boots the computer and manages the file
system. Almost all modern operating systems can support more than one user, task, or CPU.

Roles of an operating system include

n Control hardware access

n Manage files and folders

n Provide user interface

n Manage applications

Describe Characteristics of Modern Operating
Systems
Regardless of the size and complexity of the computer and the operating system, all operat-
ing systems perform the same four basic functions. Operating systems control hardware
access, manage files and folders, provide a user interface, and manage applications.

Control Hardware Access
The operating system manages the interaction between applications and the hardware. To
access and communicate with the hardware, the operating system installs a device driver for
each hardware component. A device driver is a small program written by the hardware
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manufacturer and supplied with the hardware component. When the hardware device is
installed, the device driver is also installed, allowing the OS to communicate with the hard-
ware component.

The process of assigning system resources and installing drivers can be performed with
Plug and Play (PnP). The PnP process was introduced in Windows 95 to simplify the instal-
lation of new hardware. All modern operating systems are PnP-compatible. With PnP, the
operating system automatically detects the PnP-compatible hardware and installs the driver
for that component. The operating system then configures the device and updates the
Registry, which is a database that contains all the information about the computer.

Note
The Registry contains information about applications, users, hardware, network settings, and file
types.

File and Folder Management
The operating system creates a file structure on the hard disk drive to allow data to be
stored. A file is a block of related data that is given a single name and treated as a single
unit. Program and data files are grouped together in a directory. The files and directories are
organized for easy retrieval and use. Directories can be kept inside other directories. These
nested directories are referred to as subdirectories. Directories are called folders in
Windows operating systems, and subdirectories are called subfolders.

User Interface
The operating system enables the user to interact with software and hardware. There are
two types of user interfaces:

n Command-line interface (CLI): The user types commands at a prompt, as shown in
Figure 5-1.

n Graphical user interface (GUI): The user interacts with menus and icons, as shown in
Figure 5-2.

Most operating systems, such as Windows 2000, Windows XP, Windows Vista, and
Windows 7, include both a GUI and a CLI.
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Figure 5-1 Command-Line Interface
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Figure 5-2 Graphical User Interface
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Application Management
The operating system locates an application and loads it into the RAM of the computer.
Applications are software programs, such as word processors, databases, spreadsheets,
games, and many other applications. The operating system ensures that each application has
adequate system resources.

An application programming interface (API) is a set of guidelines used by programmers to
ensure that the application they are developing is compatible with an operating system.
Here are two examples of APIs:

n Open Graphics Library (OpenGL): Cross-platform standard specification for multi-
media graphics

n DirectX: Collection of APIs related to multimedia tasks for Microsoft Windows

Explain Operating System Concepts
To understand the capabilities of an operating system, it is important to understand some
basic terms. The following terms are often used when comparing operating systems:

n Multiuser: Two or more users can work with programs and share peripheral devices,
such as printers, at the same time.

n Multitasking: The computer is capable of operating multiple applications at the same
time.

n Multiprocessing: The computer can have two or more central processing units (CPU)
that programs share.

n Multithreading: A program can be broken into smaller parts that can be loaded as
needed by the operating system. Multithreading allows individual programs to be mul-
titasked.

Almost all modern operating systems are multiuser and multitasking, and they support mul-
tiprocessing and multithreading.

Modes of Operation
All modern CPUs can run in different modes of operation. The mode of operation refers to
the capability of the CPU and the operating environment. The mode of operation deter-
mines how the CPU manages applications and memory. Table 5-1 shows an example of the
logical memory allocation. The four common modes of operation are real mode, protected
mode, virtual real mode, and compatible mode.
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Table 5-1 Memory Management

Memory Type Logical Memory Allocation

Conventional 0 to 640 KB

Upper 640 KB to 1 MB

Extended 1 MB to the maximum amount of RAM installed

Real Mode
A CPU that operates in real mode can execute only one program at a time, and can address
only 1 MB of system memory. Although all modern processors have real mode available, it
is used only by DOS and DOS applications in old operating systems and by 16-bit operat-
ing environments, such as Windows 3.x.

Protected Mode
A CPU that operates in protected mode has access to all of the memory in the computer,
including virtual memory. Virtual memory is hard disk space that is used to emulate RAM.
Operating systems that use protected mode can manage multiple programs simultaneously.
Protected mode provides 32-bit access to memory, drivers, and transfers between input and
output (I/O) devices. Protected mode is used by 32-bit operating systems, such as Windows
2000 and Windows XP. In protected mode, applications are protected from using the memo-
ry reserved for another application that is currently running.

Virtual Real Mode
A CPU that operates in virtual real mode allows a real-mode application to run within a
protected-mode operating system. This can be demonstrated when a DOS application runs
in a 32-bit operating system, such as Windows XP. Table 5-2 is a chart of some common
DOS commands that can still be used in modern operating systems, such as Windows XP.

Table 5-2 Common DOS Commands

Command Function

help Provides command-line help

dir Displays the contents of a directory

attrib Changes the attributes of a file to indicate a read-only,
archive, system, or hidden file

edit Opens a file for editing

continues
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Table 5-2 Common DOS Commands continued

Command Function

copy Copies a file

xcopy Copies files and subdirectories

format Formats a disk

md Makes a new directory

cd Changes to a specified directory

rd Removes a directory

Compatibility Mode
Compatibility mode creates the environment of an earlier operating system for applications
that are not compatible with the current operating system. As an example, an application
that checks the version of the operating system might be written for Windows NT and
require a particular service pack. Compatibility mode can create the proper environment or
version of the operating system to allow the application to run as if it is in the intended
environment.

Although Windows Vista is highly compatible with previous versions of Windows, two par-
ticularly useful features are available. The first feature is Windows XP Service Pack 2 (SP2)
compatibility mode. This allows applications that are not compatible with Windows Vista to
be executed as if the operating system were Windows XP SP2. The second feature is a
method to override the User Account Control (UAC). This allows an application to be run
even if the user does not have the required administrative privileges.

32-Bit Versus 64-Bit
There are three main differences between 32-bit and 64-bit operating systems. A 32-bit
operating system, such as Windows XP Professional, is capable of addressing only 4 GB of
RAM, while a 64-bit operating system can address more than 128 GB of RAM. Memory
management is also different between these two types of operating systems, resulting in
enhanced performance of 64-bit programs. A 64-bit operating system, such as Windows
Vista 64-bit, has additional security features such as Kernel Patch Protection (KPP) and
mandatory driver signing. With KPP, third-party drivers cannot modify the kernel. With
mandatory driver signing, unsigned drivers cannot be used.
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Processor Architecture
There are two common architectures used by CPUs to process data: x86 (32-bit architec-
ture) and x64 (64-bit architecture). x86 uses a complex instruction set computing (CISC)
architecture to process multiple instructions with a single request. Registers are storage
areas used by the CPU when performing calculations. x86 processors use fewer registers
than x64 processors. x64 architecture is backward compatible with x86 and adds additional
registers specifically for instructions that use a 64-bit address space. The additional registers
of the x64 architecture allow the computer to process much more complex instructions at a
much higher rate.

Describe and Compare Operating Systems to
Include Purpose, Limitations, and
Compatibilities
A technician might be asked to choose and install an operating system for a customer. The
type of OS selected depends on the customer’s requirements for the computer. There are
two distinct types of operating systems: desktop operating systems and network operating
systems. A desktop operating system is intended for use in a small office/home office
(SOHO) with a limited number of users. A network operating system (NOS) is designed for
a corporate environment serving multiple users with a wide range of needs.

After completing this section, you will meet these objectives:

n Describe desktop operating systems.

n Describe network operating systems.

Describe Desktop Operating Systems
A desktop OS has the following characteristics:

n Supports a single user

n Runs single-user applications

n Shares files and folders on a small network with limited security

In the current software market, the most commonly used desktop operating systems fall into
three groups: Microsoft Windows, Apple Mac OS, and UNIX/Linux.
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Microsoft Windows
Windows is one of the most popular operating systems today. The following products are
desktop versions of the Microsoft Windows operating systems:

n Windows XP Professional: Used on most computers that will connect to a Windows
Server on a network

n Windows XP Home Edition: Used on home computers and has very limited security

n Windows XP Media Center: Used on entertainment computers for viewing movies
and listening to music

n Windows XP Tablet PC Edition: Used for tablet PCs

n Windows XP 64-bit Edition: Used for computers with 64-bit processors

n Windows 2000 Professional: Older Windows operating system that has been replaced
by Windows XP Professional

n Windows Vista Home Basic: Used on home computers for basic computing

n Windows Vista Home Premium: Used on home computers to expand personal pro-
ductivity and digital entertainment beyond the basics

n Windows Vista Business: Used on small business computers for enhanced security
and enhanced mobility technology

n Windows Vista Ultimate: Used on computers to combine all the needs of both home
and business users

n Windows 7 Home Premium: Used on home computers to expand personal productivi-
ty and digital entertainment beyond the basics

n Windows 7 Professional: Used on small business computers for enhanced security and
enhanced mobility technology

n Windows 7 Ultimate: Used on computers to combine all the needs of both home and
business users

Apple Mac OS
Apple computers are proprietary and use an operating system called Mac OS. Mac OS is
designed to be a user-friendly GUI operating system. Mac OS X is based on a customized
version of UNIX.
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UNIX/Linux
UNIX, which was introduced in the late 1960s, is one of the oldest operating systems.
There are many different versions of UNIX today. One of the most recent is the extremely
popular Linux. Linux was developed by Linus Torvalds in 1991, and it is designed as an
open-source operating system. Open-source programs allow the source code to be distrib-
uted and changed by anyone as a free download or from developers at a much lower cost
than other operating systems.

Note
In this course, all command paths refer to Windows XP unless otherwise noted.

Describe Network Operating Systems
A network OS has the following characteristics:

n Supports multiple users

n Runs multiuser applications

n Is robust and redundant

n Provides increased security compared to desktop operating systems

These are the most common network operating systems:

n Microsoft Windows: Network operating systems offered by Microsoft are Windows
2000 Server, Windows Server 2003, and Windows Server 2008. Windows Server oper-
ating systems use a central database called Active Directory to manage network
resources.

n Novell NetWare: Novell NetWare was the first OS to meet network OS requirements
and enjoy widespread deployment in PC-based local-area networks (LAN) back in the
1980s.

n Linux: Linux operating systems include Red Hat, Caldera, SUSE, Debian, Fedora,
Ubuntu, and Slackware.

n UNIX: Various corporations offer proprietary operating systems based on UNIX.

Worksheet 5.2.2: NOS Certifications and Jobs

In this activity, you will use the Internet, a newspaper, or magazines to gather information
about network operating system certifications and jobs that require these certifications.
Refer to the worksheet in IT Essentials: PC Hardware and Software Lab Manual, Fourth
Edition. You can complete this worksheet now or wait to do so until the end of the chapter. 
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Determine Operating System Based on
Customer Needs
To select the proper operating system to meet the requirements of your customer, you need
to understand how the customer wants to use the computer. The operating system that you
recommend should be compatible with any applications that will be used and should sup-
port all hardware that is installed in the computer. If the computer will be attached to a net-
work, the new operating system should also be compatible with other operating systems on
the network.

After completing this section, you will meet these objectives:

n Identify applications and environments that are compatible with an operating system.

n Determine minimum hardware requirements and compatibility with the OS platform.

Identify Applications and Environments That Are
Compatible with an Operating System
An operating system should be compatible with all applications that are installed on a com-
puter. Before recommending an OS to your customer, investigate the types of applications
that your customer will be using. If the computer will be part of a network, the operating
system must also be compatible with the operating systems of the other computers in the
network. The network type determines which operating systems are compatible. Microsoft
Windows networks can have multiple computers using different versions of Microsoft oper-
ating systems. These are some guidelines that will help you determine the best operating
system for your customer:

n Does the computer have “off-the-shelf” applications or customized applications that
were programmed specifically for this customer? If the customer will be using a cus-
tomized application, the programmer of that application will specify which operating
system is compatible with it. Most off-the-shelf applications specify a list of compati-
ble operating systems on the outside of the application package.

n Are the applications programmed for a single user or multiple users? This information
helps you decide whether to recommend a desktop OS or a network OS. If the comput-
er will be connected to a network, make sure to recommend the same OS platform that
the other computers on the network use.

n Are any data files shared with other computers, such as a laptop or home computer? To
ensure compatibility of file formats, recommend the same OS platform that the other
data file–sharing computers use.

As an example, your customer has a Windows network installed and wants to add more
computers to the network. In this case, you should recommend a Windows OS for the new
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computers. If the customer does not have any existing computer equipment, the choice of
available OS platforms increases. To make an OS recommendation, you must review budget
constraints, learn how the computer will be used, and determine which types of applications
will be installed.

Determine Minimum Hardware Requirements and
Compatibility with the OS Platform
Operating systems have minimum hardware requirements that must be met for the OS to
install and function correctly. Table 5-3 provide a chart of the minimum hardware require-
ments and features for the various Windows operating systems.

Table 5-3 Minimum Hardware Requirements

Windows 2000 Windows XP Windows Vista Windows 7

CPU 133 MHz 233 MHz 800 MHz 1 GHz

RAM 64 MB 64 MB 512 MB 1 GB

Hard drive 650 MB 1.5 GB 15 GB 16 GB

Other CD drive or CD or CD or DVD drive CD or DVD 
floppy drive DVD drive drive

WDDM 
video driver DirectX9 graphics

device with WDDM 
video driver

Identify the equipment that your customer has in place. If hardware upgrades are necessary
to meet the minimum requirements for an OS, conduct a cost analysis to determine the best
course of action. In some cases, it might be less expensive for the customer to purchase a
new computer than to upgrade the current system. In other cases, it might be cost effective
to upgrade one or more of the following components:

n RAM

n Hard disk drive

n CPU

n Video adapter card

Note
In some cases, the application requirements might exceed the hardware requirements of the operating
system. For the application to function properly, it is necessary to satisfy the additional requirements.

Chapter 5: Fundamental Operating Systems 127

9781587132636_ch05.qxp  8/20/10  1:38 PM  Page 127

DRAFT



After you have determined the minimum hardware requirements for an OS, ensure that all
hardware in the computer is compatible with the OS that you have selected for your cus-
tomer.

Hardware Compatibility List
Most operating systems have a hardware compatibility list (HCL) that can be found on the
manufacturer’s website, as shown in Figure 5-3. These lists provide a detailed inventory of
hardware that has been tested and is known to work with the operating system. If any of
your customer’s existing hardware is not on the list, those components might need to be
upgraded to match components on the HCL.

Figure 5-3 Hardware Compatibility List
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Worksheet 5.3.2: Upgrade Hardware Components

In this worksheet, you will use the Internet, a newspaper, or a local store to gather informa-
tion about hardware components. The scenario is that your customer’s computer currently
has one module of 256-MB RAM, a 40-GB hard disk drive, and an AGP video adapter card
with 32 MB of RAM. Your customer wants to be able to play advanced video games. Refer
to the worksheet in IT Essentials: PC Hardware and Software Lab Manual, Fourth Edition.
You can complete this worksheet now or wait to do so until the end of the chapter. 

Install an Operating System
As a technician, you might have to perform a clean installation of an operating system.
Perform a clean install in the following situations:

n When a computer is passed from one employee to another

n When the operating system is corrupted

n When a new replacement hard drive is installed in a computer

Figure 5-4 shows an example of the Windows XP installation welcome screen.

Figure 5-4 Windows XP Installation
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After completing this section, you will meet these objectives:

n Identify hard drive setup procedures.

n Prepare the hard drive.

n Install the operating system using default settings.

n Create user accounts.

9781587132636_ch05.qxp  8/20/10  1:38 PM  Page 129

DRAFT



n Complete the installation.

n Describe custom installation options.

n Identify the boot sequence files and Registry files.

n Describe how to manipulate operating system files.

n Describe directory structures.

Identify Hard Drive Setup Procedures
The installation and initial booting of the operating system is called the operating system
setup. Although it is possible to install an operating system over a network from a server or
from a local hard drive, the most common installation method is with CDs and DVDs. To
install an OS from a CD or DVD, first configure the BIOS setup to boot the system from
the CD or DVD.

Partitioning and Formatting
Before installing an operating system on a hard drive, the hard drive must be partitioned
and formatted. When a hard drive is partitioned, it is logically divided into one or more
areas. When a hard drive is formatted, the partitions are prepared to hold files and applica-
tions. During the installation phase, most operating systems automatically partition and for-
mat the hard drive. A technician should understand the process relating to hard drive setup.
The following terms are used when referring to hard drive setup:

n Primary partition: This partition is usually the first partition. A primary partition can-
not be subdivided into smaller sections. There can be up to four partitions per hard
drive.

n Active partition: This partition is the partition used by the operating system to boot the
computer. Only one primary partition can be marked active.

n Extended partition: This partition normally uses the remaining free space on a hard
drive or takes the place of a primary partition. There can be only one extended partition
per hard drive, and it can be subdivided into smaller sections called logical drives.

n Logical drive: This drive is a section of an extended partition that can be used to sepa-
rate information for administrative purposes.

n Formatting: This process prepares a file system in a partition for files to be stored.

n Sector: A sector contains a fixed number of bytes, generally at least 512.

n Cluster: A cluster is also called a file allocation unit. It is the smallest unit of space
used for storing data. It is made up of one or more sectors.
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n Track: A track is one complete circle of data on one side of a hard drive platter. A
track is broken into groups of sectors.

n Cylinder: A cylinder is a stack of tracks lined up one on top of another to form a cylin-
der shape.

n Drive mapping: Drive mapping is a letter assigned to a logical drive.

Figure 5-5 shows how the different parts of a hard drive correspond.

Figure 5-5 Hard Drive Access
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Prepare the Hard Drive
A clean installation of an operating system proceeds as if the disk were brand new; there is
no attempt to preserve any information that is currently on the hard drive. The first phase of
the installation process entails partitioning and formatting the hard drive. This process pre-
pares the disk to accept the file system. The file system provides the directory structure that
organizes the user’s operating system, application, configuration, and data files.

9781587132636_ch05.qxp  8/20/10  1:38 PM  Page 131

DRAFT



The Windows XP operating system can use one of two file systems:

n File Allocation Table, 32-bit (FAT32): A file system that can support partition sizes up
to 2 TB or 2048 GB. The FAT32 file system is supported by Windows 9.x, Windows
Me, Windows 2000, and Windows XP. 

n New Technology File System (NTFS): A file system that can support partition sizes up
to 16 exabytes, in theory. NTFS incorporates more file system security features and
extended attributes than the FAT file system.

Figure 5-6 through Figure 5-10 show the five steps required to partition and format a drive
in Windows XP.

Figure 5-6 Hard Drive Preparation and Setup: Step 1
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Figure 5-8 Hard Drive Preparation and Setup: Step 3
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Figure 5-9 Hard Drive Preparation and Setup: Step 4

The Windows Vista operating system will automatically create a partition on the entire hard
drive, format it for you, and begin installing Windows if you do not create your own parti-
tions using the New option. If you decide to create and format your own partitions, the
process is the same as Windows XP, except that Windows Vista does not provide a choice
of file systems. NTFS formats the partition in which Windows Vista will be installed.
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Figure 5-10 Hard Drive Preparation and Setup: Step 5

134 IT Essentials: PC Hardware and Software Companion Guide

Lab 5.4.2: Install Windows XP

In this lab, you will install the Windows XP Professional operating system. Refer to the lab
in IT Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You can perform
this lab now or wait until the end of the chapter.

Optional Lab 5.4.2: Install Windows Vista

In this optional lab, you will install the Windows Vista operating system. Refer to the lab in
IT Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You can perform
this lab now or wait until the end of the chapter.

Install the Operating System Using Default Settings
When you’re installing Windows XP, the installation wizard gives the option to install using
typical (default) settings or custom settings. Using the typical settings increases the likeli-
hood of a successful installation. However, the user must still provide the following infor-
mation during the setup:

n Standards and formats that define currency and numerals

n Text input language

n Name of the user and company

n Product key

n Computer name
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n Administrator password

n Date and time settings

n Network settings

n Domain or workgroup information

When a computer boots up with the Windows installation disc, the Windows XP installation
starts with three options:

n Setup XP: To run the setup and install the XP operating system, press Enter.

n Repair XP: To repair an installation, press R to open the Recovery Console. The
Recovery Console is a troubleshooting tool. It can be used to create and format parti-
tions and repair the boot sector or Master Boot Record. It can also perform basic file
operations on operating system files and folders. The Recovery Console configures
services and devices to start or not start the next time the computer boots up.

n Quit: To quit Setup without installing Windows XP, press F3.

For this section, select the Setup XP option.

Figure 5-11 shows the installation window for Windows XP. 

Figure 5-11 Installing Windows
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Windows setup searches for existing Windows installations. If no existing installation is
found, you can perform a clean installation of Windows. If an existing installation is found,
you have the option of performing a repair installation. A repair installation fixes the current
installation using the original files from the Windows XP installation disc. Before perform-
ing a repair installation, back up any important files to a different physical location such as
a second hard drive, CD, or USB storage device.

After a repair installation begins, Windows setup copies installation files to the hard drive
and reboots. Following the reboot, a message to press any key to boot from CD appears. Do
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not press any keys at this time. Setup continues to install Windows as if it were a clean
install, but any applications that you have installed and any settings that you have config-
ured remain unchanged.

When a computer boots up with the Windows Vista installation disc, Windows Vista instal-
lation starts with three options:

n Upgrade: Keep your files, settings, and programs and upgrade Windows. Also use this
option to repair an installation.

n Custom (advanced): Install a clean copy of Windows, select where you want to install
it, or make changes to disks and partitions.

n Quit: To quit Setup, click the x in the Close box.

Create User Accounts
An administrator account is automatically created when Windows XP is installed. The
default administrator account is named “administrator.” For security purposes, change this
name as soon as possible. Use this privileged account to manage the computer only. Do not
use it as a daily account. People have accidentally made drastic changes while using the
administrator account instead of a regular user account. Attackers seek out the administrator
account because it is so powerful.

Create a user account when prompted during the installation process. Unlike the administra-
tor account, user accounts can be created at any time. A user account has fewer permissions
than the computer administrator. For example, users may have the right to read, but not
modify, a file.

Figure 5-12 shows the installation screen for setting the computer name and setting the ini-
tial administrator password.

Figure 5-12 Creating an Administrator Account
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Complete the Installation
After the Windows installation copies all of the necessary operating system files to the hard
drive, the computer reboots and prompts you to log in for the first time.

You must register Windows XP. As shown in Figure 5-13, you must also complete the veri-
fication that ensures that you are using a legal copy of the OS. Doing so enables you to
download patches and service packs. Performing this step requires a connection to the
Internet.

Figure 5-13 Activating Windows XP After Installation
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Depending on the age of the media at the time of your installation, there might be updates
to install. As shown in Figure 5-14, you can use Microsoft Update Manager from the Start
menu to scan for new software and to do the following:

n Install all service packs.

n Install all patches.

To start the update process navigate to Start > All Programs > Accessories > System Tools
> Windows Update.

In Windows Vista, use the following path to access Windows Update: Start > All
Programs > Windows Update.

You should also verify that all hardware is installed correctly. As shown in Figure 5-15, you
can use Device Manager to locate problems and to install the correct or updated drivers
using the following path:

Start > Control Panel > System > Hardware > Device Manager
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Figure 5-14 Microsoft Update
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Figure 5-15 Device Manager Conflicts

In Device Manager, warning icons are represented by a yellow exclamation point or a red
X. A yellow exclamation point represents a problem with the device. To view the problem
description, right-click the device and select Properties. A red X represents a device that
has been disabled. To enable the device, right-click the disabled device and select Enable.
To open a category that is not yet expanded, click the plus (+) sign.
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Note
When Windows detects a system error, Windows reporting displays a dialog box. If you choose to
send the report, Microsoft Windows Error Reporting (WER) collects information about the applica-
tion and the module involved in the error and sends the information to Microsoft.

Lab 5.4.5: Create Accounts and Check for Updates in Windows XP

In this lab, you will create user accounts and configure the operating system for Automatic
Updates after the Windows XP Professional installation process. Refer to the lab in IT
Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You can perform this
lab now or wait until the end of the chapter.

Optional Lab 5.4.5: Create Accounts and Check for Updates in Windows Vista.

In this lab, you will create user accounts and configure the operating system for Automatic
Updates after the Windows XP Professional installation process. Refer to the lab in IT
Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You can perform this
lab now or wait until the end of the chapter.

Describe Custom Installation Options
Installing an operating system on a single computer takes time. Imagine the time it would
take to install operating systems on multiple computers, one at a time, in a large organiza-
tion. To simplify this activity, you can use the Microsoft System Preparation (Sysprep) tool
to install and configure the same operating system on multiple computers. Sysprep prepares
an operating system that will be used on computers with different hardware configurations.
With Sysprep and a disk-cloning application, technicians are able to quickly install an oper-
ating system, complete the last configuration steps for the OS setup, and install applications.

Disk Cloning
There are many methods to copy an OS to speed and automate installation. A common disk
cloning technique creates an image of a hard drive in a computer. Follow these steps for
disk cloning:

Step 1. Create a master installation on one computer. This master installation includes
the operating system, software applications, and configuration settings that will
be used by the other computers in the organization.

Step 2. Run Sysprep from the run dialog box.
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Step 3. Create a disk image of the configured computer using a third-party disk-cloning
program like Norton Ghost by Symantec.

Step 4. Copy the disk image onto a server. When the destination computer is booted, a
shortened version of the Windows setup program runs. The setup creates a new
system security identifier (SID), installs drivers for hardware, creates user
accounts, and configures network settings to finish the OS install.

Network Installation
Windows can also be installed over a network:

Step 1. Prepare the computer by creating a FAT or FAT32 partition of at least 1.5 GB.
You must also make the partition bootable and include a network client. You can
also use a boot disk that contains a network client so that the computer can con-
nect to a file server over the network.

Step 2. Copy the Windows XP installation files (the I386 folder from the installation
disc) to the network server and make sure to share the directory so that clients
can connect and use the files.

Step 3. Boot the computer and connect to the shared directory.

Step 4. From the shared directory, run the setup program, WINNT.EXE. The setup pro-
gram copies all of the installation files from the network share onto your hard
drive. After the installation files have been copied, the installation continues
much the same as if the installation were performed from a disc.

Recovery Disc
You can use a recovery disc when there has been a system failure and other recovery
options have failed, such as booting in Safe Mode or booting a Last Known Good. An
Automated System Recovery (ASR) set must be created before a recovery can be per-
formed. Use the ASR Wizard in Backup to create the ASR set. The ASR Wizard creates a
backup of the system state, services, and operating system components. The ASR Wizard
also creates a file that contains information about your disks, the backup, and how to restore
the backup.

To restore the ASR, press F2 after booting the Windows XP installation disc. ASR reads the
set and restores the disks that are needed to start the computer. After the basic disk informa-
tion has been restored, ASR installs a basic version of Windows and begins restoring the
backup created by the ASR Wizard.
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Factory Recovery Partition
Some computers that have Windows XP preinstalled from the factory contain a section of
disk that is inaccessible to the user. This partition on the disk contains an image of the
bootable partition, created when the computer was built. This partition is called a factory
recovery partition and can be used to restore the computer to its original configuration.
Occasionally, the option to reach this partition for restoration is hidden and a special key or
key combination must be used when the computer is being started. The option to restore
from the factory recovery partition can also be found in the BIOS of some computers.
Contact the manufacturer to find out how you can access the partition and restore the origi-
nal configuration of the computer.

Identify the Boot Sequence Files and Registry Files
You should know the process that Windows XP uses when booting. Understanding these
steps can help you to troubleshoot boot problems. 

Windows XP Boot Process
To begin the boot process, you first turn on the computer, which is called a cold boot. The
computer performs the Power On Self Test (POST). Because the video adapter has not yet
been initialized, any errors that occur at this point in the boot process are reported by a
series of audible tones, called beep codes.

After POST, the BIOS locates and reads the configuration settings that are stored in the
CMOS. This configuration setting, called the boot device priority, is the order in which
devices are checked to see if an operating system is located there. The boot device priority
is set in the BIOS and can be arranged in any order. The BIOS boots the computer using the
first drive that contains an operating system.

One common boot order is floppy drive, CD-ROM drive, and then the hard drive. This
order allows you to use removable media to boot the computer. The BIOS checks the floppy
drive, the CD-ROM, and finally the hard drive for an operating system to boot the comput-
er. Network drives, USB drives, and even removable magnetic media, such as
CompactFlash or Secure Digital (SD) cards, can also be used in the boot order, depending
on the capabilities of the motherboard. Some BIOS also have a boot device priority menu
that can be accessed using a special key combination while the computer is starting but
before the boot sequence begins. You can use this menu to choose the device that you want
to boot, which is useful if multiple drives can boot the computer.

When the drive with the operating system is located, the BIOS locates the Master Boot
Record (MBR). The MBR locates the operating system boot loader. For Windows XP, the
boot loader is called NT Loader (NTLDR).
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NTLDR and the Windows Boot Menu
At this point, NTLDR controls several installation steps. For instance, if more than one OS
is present on the disk, BOOT.INI gives the user a chance to select which one to use. If there
are no other operating systems, or if the user does not make a selection before the timer
expires, the following steps occur:

n NTLDR runs NTDETECT.COM to get information about the installed hardware.

n NTLDR then uses the path specified in BOOT.INI to find the boot partition.

n NTLDR loads two files that make up the core of XP: NTOSKRNL.EXE and
HAL.DLL.

n NTLDR reads the Registry files, chooses a hardware profile, and loads the device 
drivers.

Windows Registry
The Windows Registry files are an important part of the Windows XP boot process. These
files are recognized by their distinctive names, which begin with HKEY_, as shown in
Table 5-4, followed by the name of the portion of the operating system under their control.
Every setting in Windows—from the background of the desktop and the color of the screen
buttons to the licensing of applications—is stored in the Registry. When a user makes
changes to the Control Panel settings, File Associations, System Policies, or installed soft-
ware, the changes are stored in the Registry.

Table 5-4 Registry Keys

Key Description

HKEY_CLASSES_ROOT Information about which file extensions map to a par-
ticular application

HKEY_CURRENT_USER Information, such as desktop settings and history, relat-
ed to the current user of a PC

HKEY_USERS Information about all users who have logged on to a
system

HKEY_LOCAL_MACHINE Information relating to the hardware and software

HKEY_CURRENT_CONFIG Information relating to all active devices on a system

Each user has a unique section of the Registry. The Windows login process pulls system
settings from the Registry to reconfigure the system to the state that it was in the last time
that the user turned it on.
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NT Kernel
At this point, the NT kernel, the heart of the Windows operating system, takes over. The
name of this file is NTOSKRNL.EXE. It starts the login file called WINLOGON.EXE and
displays the XP welcome screen.

Note
If a SCSI drive will boot the computer, Windows copies the NTBOOTDD.SYS file during installa-
tion. This file is not copied if SCSI drives are not being used.

Describe How to Manipulate Operating System Files
After you have installed Windows XP, you might want to make changes to the configura-
tion. The following applications are used extensively for post-installation diagnostics and
modifications and can be executed by entering their names in the run dialog box:

n Msconfig: This command starts the System configuration utility, as shown in Figure 5-
16. It allows you to set the programs that run at startup and to edit configuration files.
It also offers simplified control over Windows Services. 

Figure 5-16 Msconfig
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n Regedit: This application, named Registry Editor, as shown in Figure 5-17, allows you
to edit the Registry. Make sure you back up the PC before making any changes using
Regedit. 
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Figure 5-17 Regedit
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n Msinfo32: This utility displays a complete system summary of your computer, includ-
ing hardware components and details and installed software and settings. 

n Dxdiag: This utility shows details about all of the DirectX components and drivers that
are installed in your computer. You can use this utility to ensure that DirectX is
installed properly and configured correctly.

n Cmd: This command opens a command window when it is entered in the Run dialog
box. This is used to execute command-line programs and utilities.

Note
REGEDT32.EXE was used with Windows NT. In Windows XP, and Windows Server 2003, the
REGEDT32.EXE file is a shortcut to the REGEDIT.EXE command. In Windows XP, you can enter
REGEDT32.EXE or REGEDIT.EXE; both commands run the same program.

Caution
Using REGEDT32.EXE or REGEDIT.EXE incorrectly might cause configuration problems that
could require you to reinstall the operating system; therefore, make a backup copy of your Registry
from within Regedit before you use either command.

Startup Modes
You can boot Windows in one of many different modes. Pressing the F8 key during the boot
process opens the Windows Advanced Startup Options menu, which allows you to select
how to boot Windows. The following startup options are commonly used:

n Safe Mode: Starts Windows but only loads drivers for basic components, such as the
keyboard and display.
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n Safe Mode with Networking Support: Starts Windows identically to Safe Mode and
also loads the drivers for network components.

n Safe Mode with Command Prompt: Starts Windows and loads the command prompt
instead of the GUI.

n Last Known Good Configuration: Enables a user to load the configuration settings of
Windows that were used the last time that Windows started successfully. It does this by
accessing a copy of the Registry that is created for this purpose.

n Boot Normally: Starts Windows and loads all the drivers and boots with no 
modifications. 

Note
Last Known Good Configuration is not useful unless it is applied immediately after a failure occurs.
If the machine is restarted and, despite its difficulties, manages to open Windows, the Registry key
for Last Known Good Configuration will probably be updated with the faulty information.

Describe Directory Structures
Operating systems have organized locations for files and applications. The directory struc-
tures in Windows operating systems are quite similar among the versions. A path is a
description of where a file is located within the directory structure.  

File Extensions and Attributes
In Windows, the root level of the Windows partition is usually labeled drive C:\. Next, there
is an initial set of standardized directories, called folders, for the operating system, applica-
tions, configuration information, and data files. Following the initial installation, users can
install most applications and data in whichever directory they choose.

Files in the directory structure adhere to a Windows naming convention:

n Maximum of 255 characters can be used.

n Characters such as a slash or a backslash (/ \) are not allowed.

n An extension of three or four letters is added to the filename to identify the file type.

n Filenames are not case sensitive.

The following filename extensions are commonly used:

n .doc: Microsoft Word 2003 and earlier

n .docx: Microsoft Word 2007 and later

n .txt: ASCII text only
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n .jpg: Graphics format

n .ppt: Microsoft PowerPoint

n .zip: Compression format

The directory structure maintains a set of attributes for each file that controls how the file
can be viewed or altered. These are the most common file attributes:

n R: The file is read-only.

n A: The file will be archived the next time that the disk is backed up.

n S: The file is marked as a system file, and a warning is given if an attempt is made to
delete or modify the file.

n H: The file is hidden in the directory display.

You can view the filenames, extensions, and attributes by entering the ATTRIB command
in a DOS window, as shown in Figure 5-18. Choose Start > Run, type cmd, and press
Enter.

In Windows Vista, choose Start > Start Search, type cmd, and press Enter.

Figure 5-18 File Attributes
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Navigate to the folder that contains the file that you are interested in. Type ATTRIB fol-
lowed by the filename. Use a wildcard such as *.* to view many files at once. The attributes
of each file appear in the left column of the screen. To get information about the ATTRIB
command, type the following at the command prompt:

ATTRIB/?

You can access the Windows equivalent of ATTRIB by right-clicking a file in Windows
Explorer and choosing Properties.
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Note
To see the properties of a file in Windows Explorer, you must first set Windows Explorer to Show
Hidden Files. Right-click Start and choose Explore > Tools > Folder Options > View. In Windows
Vista, right-click Start and choose Explore > Organize > Folder and Search Options > View.

Describe NTFS and FAT32
Windows XP and Windows 2000 use FAT32 or NTFS, while Windows Vista uses NTFS.
Security is one of the most important differences between these file systems. NTFS can
support more and larger files than FAT32 and provides more flexible security features for
files and folders. Figure 5-19 shows the file permission properties for FAT32 and NTFS.

Figure 5-19 NTFS Permissions
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To use the extra security advantages of NTFS, you can convert partitions from FAT32 to
NTFS using the CONVERT.EXE utility. To restore an NTFS partition back to a FAT32 par-
tition, reformat the partition and restore the data from a backup.

Caution
Before converting a file system, remember to back up the data.

Lab 5.4.8: Managing System Files with Built-in Utilities in Windows XP

In this lab, you will manage system files with built-in utilities in Windows XP. Refer to the
lab in IT Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You can per-
form this lab now or wait until the end of the chapter.
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Optional Lab 5.4.8: Managing System Files with Built-in Utilities in Windows Vista

In this lab, you will manage system files with built-in utilities in Windows Vista. Refer to
the lab in IT Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You can
perform this lab now or wait until the end of the chapter.

Worksheet 5.4.9: Answer NTFS and FAT32 Questions

In this worksheet, you will answer questions about NTFS and FAT32, which are file sys-
tems used by the Windows XP operating system and provide different file system features.
Refer to the worksheet in IT Essentials: PC Hardware and Software Lab Manual, Fourth
Edition. You can complete this worksheet now or wait to do so until the end of the chapter. 

Navigate a GUI (Windows)
The operating system provides a user interface that allows you to interact with the comput-
er. There are two methods that you can use to navigate the file system and run applications
within an operating system:

n A graphical user interface (GUI), as shown in Figure 5-20, provides graphical represen-
tations (icons) of all the files, folders, and programs on a computer. You manipulate these
icons using a pointer that is controlled with a mouse or similar device. The pointer
allows you to move icons by dragging and dropping, and execute programs by clicking.

n A command-line interface (CLI) is text based. You must type commands to manipulate
files and execute programs.

After completing this section, you will meet these objectives:

n Manipulate items on the desktop.

n Explore Control Panel applets.

n Explore Administrative Tools.

n Install, navigate, and uninstall an application.

n Describe upgrading an operating system.
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Figure 5-20 Operating System Navigation
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Manipulate Items on the Desktop
After the operating system has been installed, the desktop can be customized to suit individ-
ual needs. A desktop on a computer is a graphical representation of a workspace. The desk-
top has icons, toolbars, and menus to manipulate files. The desktop can be customized with
images, sounds, and colors to provide a more personalized look and feel. All of these cus-
tomizable items together make up a theme. Windows Vista has a special theme called Aero.
Aero is the default theme and has translucent window borders, numerous animations, and
live icons that are thumbnail images of the contents of a file. Because of the advanced
graphics needed, the Aero theme can only be used on computers that meet certain hardware
requirements.

Note
Windows Vista Home Basic does not include the Aero theme.
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In Windows Vista, a feature called the Sidebar can also be personalized. The Sidebar is a
graphical pane on the desktop that keeps small programs called gadgets organized. Gadgets
are small applications such as games, sticky notes, or a clock. Gadgets, like interfaces to
web information such as weather maps or contacts on a social networking site, can also be
added. Sidebar can be activated by navigating to Start > All Programs > Accessories >
Windows Sidebar. It can be customized by right-clicking the Sidebar.

Display Properties
To customize the Windows XP GUI of your desktop, right-click the desktop and choose
Properties, as shown in Figure 5-21. The Display Properties window has five tabs: Themes,
Desktop, Screen Saver, Appearance, and Settings. Click any of these tabs to customize your
display settings. In Windows Vista, right-click the desktop and choose Personalize. The
Personalization window has seven links: Window Color and Appearance, Desktop
Background, Screen Saver, Sounds, Mouse Pointers, Themes, and Display Settings. Click
any of these links to customize your display settings.

Figure 5-21 Accessing Desktop Properties
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Desktop Items
There are several items on the desktop that can be customized, such as the taskbar and
Recycle Bin. To customize any item, right-click the item and then choose Properties.
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Start Menu
On the desktop, the Start menu is accessed by clicking the Start button. The Start menu,
shown in Figure 5-22, displays all of the applications installed in the computer, a list of
recently opened documents, and a list of other elements, such as a search feature, help cen-
ter, and system settings. The Start menu can also be customized. There are two styles of
Start menu: XP and Classic. The XP-style Start menu is used throughout this course for
demonstrating command sequences.

Figure 5-22 Start Menu
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My Computer
To access the various drives installed in the computer, double-click the My Computer icon
that appears on the desktop. If it does not appear on the desktop, you can reinstate it by
right-clicking the desktop, choosing Properties, and clicking Customize Desktop on the
Desktop tab. Check My Computer under Desktop Icons. Click OK and Apply. To cus-
tomize certain settings, right-click My Computer and choose Properties. Settings that can
be customized include the following:

n Computer name

n Hardware settings

n Virtual memory
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n Automatic Updates

n Remote access

Note
In Windows Vista, My Computer is called Computer. To customize certain settings, click the Start
button, right-click Computer, and choose Properties. Access installed drives in Windows Vista with
the following path: Start > Computer.

Launching Applications
You can launch applications in several ways:

n Click the application on the Start menu.

n Double-click the application shortcut icon on the desktop.

n Double-click the application executable file in My Computer.

n Launch the application from the Run dialog box or command line.

My Network Places
To view and configure network connections, right-click the My Network Places icon on
the desktop. In My Network Places, you can connect to or disconnect from a network drive.
Click Properties to configure existing network connections, such as a wired or wireless
LAN connection.

Note
In Windows Vista, My Network Places is called Network.

Lab 5.5.1: Run Commands in Windows XP

In this lab, you will navigate Windows XP both by GUI and by the command line. Open
programs by using either Windows Explorer and the Run command. Refer to the lab in IT
Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You can perform this
lab now or wait until the end of the chapter.

Optional Lab 5.5.1: Run Commands in Windows Vista

In this lab, navigate Windows Vista both by GUI and CMD. Open the same program by
using Windows Explorer and the Run command. Refer to the lab in IT Essentials: PC
Hardware and Software Lab Manual, Fourth Edition. You can perform this lab now or wait
until the end of the chapter.
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Explore Control Panel Applets
Windows centralizes the settings for many features that control the behavior and appearance
of the computer. These settings are categorized in Control Panel applets, or small pro-
grams, found in the Control Panel, as shown in Figure 5-23. Adding or removing programs,
changing network settings, and changing the security settings are some of the configuration
options available in the Control Panel.

Figure 5-23 Control Panel
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Control Panel Applets
The names of various applets in the Control Panel differ slightly depending on the version
of Windows installed. In Windows XP, the icons are grouped into categories:

n Appearance and Themes: Applets that control the look of windows:

— Display

— Taskbar and Start Menu

— Folder Options

n Network and Internet Connections: Applets that configure all of the connection
types:

— Internet Options

— Network Connections

— Internal NIC Configuration

— Network Setup Wizard

— Windows Firewall

— Wireless Network Setup Wizard
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n Add or Remove Programs: Applet to add or remove programs and windows compo-
nents safely

n Sounds, Speech, and Audio Devices: Applets that control all of the settings for sound:

— Sounds and Audio Devices

— Speech

— Portable Media Devices

n Performance and Maintenance: Applets to find information about your computer or
perform maintenance:

— Administrative Tools

— Power Options

— Scheduled Tasks

— System

n Printers and Other Hardware: Applets to configure devices connected to your
computer:

— Game Controllers

— Keyboard

— Mouse

— Phone and Modem Options

— Printers and Faxes

— Scanners and Cameras

n User Accounts: Applets to configure options for users and their email:

— User Accounts

n Date, Time, Language, and Regional Options: Applets to change settings based on
your location and language:

— Date and Time

— Regional and Language Options

n Accessibility Options: Wizard used to configure windows for vision, hearing, and
mobility needs
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n Security Center: Applet used to configure security settings for

— Internet options

— Automatic Updates

— Windows Firewall

Display Settings
You can change the display settings by using the Display applet. Change the appearance of
the desktop by modifying the resolution and color quality, as shown in Figure 5-24. You can
change more advanced display settings, such as wallpaper, screen saver, power settings, and
other options, with the following path:

Start > Control Panel > Appearances and Themes> Display > Settings > Advanced

Use the following path in Windows Vista:

Start > Control Panel > Personalization > Display Settings > Advanced Settings

Figure 5-24 Display Settings
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Explore Administrative Tools
Administrative Tools is a collection of very powerful tools that fundamentally change the
OS. Unlike customizing the color of the desktop, these utilities create partitions, install driv-
ers, enable services, and perform other significant modifications. 
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Computer Management
The Computer Management console allows you to manage many aspects of both your com-
puter and remote computers. The Computer Management console addresses three main
areas of administration: System Tools, Storage, and Services and Applications. You must
have administrative privileges to access the Computer Management console. To view the
Computer Management console, use the following path:

Start > Control Panel > Administrative Tools > Computer Management

To view the Computer Management console for a remote computer, right-click Computer
Management (Local) in the console tree and click Connect to Another Computer. In the
Another Computer dialog box, type the name of the computer or click Browse to find a
computer you want to manage. This allows you to manage other computers on your net-
work remotely.

Device Manager
Device Manager, shown in Figure 5-25, allows you to view all of the settings for devices in
the computer. A common task for technicians is to view the values assigned for the IRQ,
I/O address, and the DMA setting for all of the devices in the computer. Those settings con-
trol how the devices interact with the OS. To view the system resources in Device Manager,
use the following path:

Start > Control Panel > System > Hardware > Device Manager > View >
Resources

In Windows Vista, use the following path:

Start > Control Panel > System > Device Manager > Continue > View > Resources

From Device Manager, you can quickly view the properties of any device in the system by
double-clicking the device name. You can view which version of the driver is installed in
your computer, view driver file details, update a driver, or even roll back or uninstall a
device driver. You can compare the driver version listed here with the version available
from the website of your device manufacturer.
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Figure 5-25 Device Manager
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Task Manager
Task Manager, shown in Figure 5-26, allows you to view all applications that are currently
running and to close any applications that have stopped responding. Task Manager allows
you to monitor the performance of the CPU and virtual memory, view all processes that are
currently running, and view information about the network connections. To view informa-
tion in Task Manager, use the following path:

Ctrl-Alt-Delete > Task Manager

In Windows Vista, use the following path:

Ctrl-Alt-Delete > Start Task Manager
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Figure 5-26 Task Manager
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Services
Services are executable programs that require little or no user input. Services can be set to
run automatically when Windows starts, or manually when required. The Services console
allows you to manage all of the services on your computer and remote computers. You can
start, stop, or disable services. You can also change how a service starts, or define actions
for the computer to perform automatically when a service fails. You must have administra-
tive privileges to access the Services console. To view the Services console, use the follow-
ing path:

Start > Control Panel > Administrative Tools > Services

To view the Services console for a remote computer, right-click Services (Local) in the
console tree and click Connect to Another Computer In the Another Computer dialog
box, type the name of the computer or click Browse to find a computer you want to manage.

Performance Monitor
The Performance Monitor console has two distinct parts: System Monitor and Performance
Logs and Alerts. System Monitor displays real-time information about the processors,
disks, memory, and network usage for your computer. You can easily summarize these
activities through histograms, graphs, and reports.

Performance Logs and Alerts allows you to record the performance data and configure
alerts. The alerts will notify you when a specified usage falls below or rises above a speci-
fied threshold. You can set alerts to create entries in the event log, send a network message,

9781587132636_ch05.qxp  8/20/10  1:38 PM  Page 158

DRAFT



begin a performance log, run a specific program, or any combination of these. You must
have administrative privileges to access the Performance Monitor console. To view the
Performance Monitor console in Windows XP, use the following path:

Start > Control Panel > Administrative Tools > Performance

In Windows Vista, use the following path:

Start > Control Panel > Administrative Tools > Reliability and Performance
Monitor > Continue

Event Viewer
Event Viewer, as shown in Figure 5-27, logs a history of events regarding applications,
security, and the system. These log files are a valuable troubleshooting tool. To access
Event Viewer, use the following path:

Start > Control Panel > Administrative Tools > Event Viewer

In Windows Vista, use the following path:

Start > Control Panel > Administrative Tools > Event Viewer > Continue

Figure 5-27 Event Viewer
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MMC
The Microsoft Management console (MMC) allows you to organize management tools,
called snap-ins, in one location for easy administration. Web page links, tasks, ActiveX con-
trols, and folders can also be added to the MMC. After you have configured an MMC, save
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it to keep all the tools and links in that MMC. You can create as many customized MMCs
as needed, each with a different name. This is useful when multiple administrators manage
different aspects of the same computer. Each administrator can have an individualized
MMC for monitoring and configuring computer settings. You must have administrative
privileges to access the MMC. For example, if one person’s job is to monitor the perform-
ance of multiple servers but that person does not need privilege to make changes, a custom
MMC can suit that network administrator. MMCs allow technicians to build a customized
“toolbox.” To view the MMC in Windows XP, use the following path: 

Start > Run, type mmc, and press Enter

In Windows Vista, use the following path:

Start > Start Search, type mmc, and press Enter

Remote Desktop
Remote Desktop allows one computer to remotely take control of another computer.
Remote technicians can use this troubleshooting feature to repair and upgrade computers.
For Windows XP, Remote Desktop is available on Windows XP Professional only. To
access Remote Desktop in Windows XP Professional, use the following path:

Start > All Programs > Accessories > Communications > Remote Desktop
Connection

In Windows Vista, use the following path:

Start > All Programs > Accessories > Remote Desktop Connection

Performance Settings
To enhance the performance of the operating system, you can change some of the settings
that your computer uses, such as virtual memory configuration settings, which are shown in
Figure 5-28. To change the virtual memory settings in Windows XP, use the following path:

Start > Control Panel > System > Advanced > Performance > Settings button

In Windows Vista, use the following path:

Start > Control Panel > System > Advanced System Settings > Continue >
Advanced > Performance > Settings > Advanced
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Figure 5-28 Virtual Memory
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Lab 5.5.3: Managing Administrative Settings and Snap-ins in Windows XP

In this lab, you will manage administrative settings and snap-ins in Windows XP. Refer to
the lab in IT Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You can
perform this lab now or wait until the end of the chapter.

Optional Lab 5.5.3: Managing Administrative Settings and Snap-ins in Windows Vista

In this lab, you will manage administrative settings and snap-ins in Windows Vista. Refer to
the lab in IT Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You can
perform this lab now or wait until the end of the chapter.

Install, Navigate, and Uninstall an Application
As a technician, you will be responsible for adding and removing software from your cus-
tomers’ computers. Most applications use an automatic installation process when an appli-
cation CD is inserted in the optical drive. The installation process updates the Add or
Remove Programs utility. The user is required to click through the installation wizard and
provide information when requested.
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Add or Remove Programs Applet
Microsoft recommends that users always use the Add or Remove Programs utility, as shown
selected in Figure 5-29, when installing or removing applications. When you use the Add or
Remove Programs utility to install an application, the utility tracks installation files so that
the application can be uninstalled completely, if desired. To open the Add or Remove
Programs applet in Windows XP, use the following path:

Start > Control Panel > Add or Remove Programs

In Windows Vista, use the following path:

Start > Control Panel > Programs and Features

Figure 5-29 Windows Add or Remove Programs
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Add an Application
If a program or application is not automatically installed when the CD is inserted, you can
use the Add or Remove Programs applet to install the application in Windows XP, as shown
in Figure 5-30. Click the Add New Programs button and navigate to where the application
is located on the CD or the downloaded file. Windows installs the application for you. In
Windows Vista, insert the CD or DVD, and the program installer should start. If the pro-
gram does not start, browse the CD or DVD and run the “setup” or “install” file to begin
installation.

After the application is installed, you can start the application from the Start menu or a
shortcut icon that the application installs on the desktop. Check the application to ensure
that it is functioning properly. If there are problems with the application, make the repair or
uninstall the application. Some applications, such as Microsoft Office, provide a repair
option in the install process. You can use this function to try to correct a program that is not
working properly.
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Figure 5-30 Add an Application
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Uninstall an Application
If an application is not uninstalled properly, you may be leaving files on the hard drive and
unnecessary settings in the Registry. This might not cause any problems, but it depletes
available hard drive space, system resources, and the speed at which the Registry is read.
Figure 5-31 shows the use of the Add or Remove Programs applet to uninstall programs in
Windows XP. The wizard guides you through the software removal process and removes
every file that was installed.

Lab 5.5.4: Install Third-Party Software in Windows XP 

In this lab, you will install third-party software in Windows XP. Refer to the lab in IT
Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You can perform this
lab now or wait until the end of the chapter.

Optional Lab 5.5.4: Install Third-Party Software in Windows Vista 

In this lab, you will install third-party software in Windows Vista. Refer to the lab in IT
Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You can perform this
lab now or wait until the end of the chapter.
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Figure 5-31 Remove an Application
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Describe Upgrading an Operating System
Sometimes it might be necessary to upgrade an operating system. Before upgrading the
operating system, check the minimum requirements of the new operating system to ensure
that the computer meets the minimum specifications. Check the HCL to ensure that the
hardware is compatible with the new operating system. Back up all data before upgrading
the operating system in case there is a problem with the installation.

Upgrading the Operating System to Windows XP
The following is how to upgrade an operating system to Windows XP:

Step 1. Back up all data.

Step 2. Insert the Windows XP disc into the optical drive to start the upgrade process.
Choose Start > Run.

Step 3. In the Run box, where D is the drive letter for the optical drive, type
D:\i386\winnt32 and press Enter. The Welcome to the Windows XP Setup
Wizard displays.

Step 4. Choose Upgrade to Windows XP and click Next. The License Agreement page
displays.

Step 5. Read the license agreement and click the button to accept this agreement.

Step 6. Click Next. The Upgrading to the Windows XP NTFS File System page 
displays.

Step 7. Follow the prompts and complete the upgrade. When the install is complete, the
computer will restart.

How To
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Note
The Windows XP Setup Wizard might automatically start when the disc is inserted into the optical
drive.

Upgrading the Operating System to Windows Vista
The following is how to upgrade an operating system to Windows Vista:

Note
Before you can upgrade from Windows XP to Windows Vista, you must install Windows XP Service
Pack 2.

Step 1. Insert the Windows Vista disc into the optical drive. The Set Up window
appears.

Step 2. Select Install Windows Vista.

Step 3. You are prompted to download any important updates for Windows Vista.

Step 4. Enter your Product Key and then agree to the End User License Agreement
(EULA).

Step 5. You are presented with two choices, Custom or Upgrade.

Step 6. Click Upgrade and setup will begin copying installation files.

Step 7. Follow the prompts and complete the upgrade. When the install is complete, the
computer will restart.

In some cases, you cannot upgrade to a newer operating system. If your operating system
cannot be upgraded, you must perform a new installation.

When a new installation of Windows is needed, you can use the Windows User State
Migration Tool (USMT) to migrate all of the current user files and settings to the new oper-
ating system. USMT allows users to restore the configurations and customizations from
their current computer to the newly installed Windows operating system. Download and
install USMT from Microsoft to create a store of user files and settings onto a separate
drive or partition. After the new operating system is installed, download and install USMT
again to restore the user files and settings to the new operating system.
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Identify and Apply Common Preventive
Maintenance Techniques for Operating
Systems
Preventive maintenance for an operating system includes organizing the system, defrag-
menting the hard drive, keeping applications current, removing unused applications, and
checking the system for errors.

After completing this section, you will meet these objectives:

n Create a preventive maintenance plan.

n Schedule a task.

n Back up the hard drive.

Create a Preventive Maintenance Plan
The goal of an operating system preventive maintenance plan is to avoid problems in the
future. Perform preventive maintenance regularly, and record all actions taken and observa-
tions made. Some preventative maintenance should take place when it causes the least
amount of disruption to the people who use the computers. This often means scheduling
tasks at night, early in the morning, or over the weekend. There are also tools and tech-
niques that can automate many preventive maintenance tasks.

Preventive Maintenance Planning
Preventive maintenance plans should include detailed information about the maintenance of
all computers and network equipment, with emphasis on equipment that could impact the
organization the most. Preventive maintenance includes the following important tasks:

n Hard drive backup 

n Hard drive defragmentation 

n Updates to the operating system and applications 

n Updates to antivirus and other protective software 

n Hard drive error checking 

A preventive maintenance program that is designed to fix things before they break, and to
solve small problems before they affect productivity, can provide the following benefits to
users and organizations:

n Decreased downtime

n Improved performance
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n Improved reliability

n Decreased repair costs

An additional part of preventive maintenance is documentation. A repair log helps you
determine which equipment is the most or least reliable. It also provides a history of when a
computer was last fixed, how it was fixed, and what the problem was.

Device Driver Updates
Manufacturers occasionally release new drivers to address issues with the current drivers.
As a best practice, you should check for updated drivers regularly. Check for updated driv-
ers when your hardware does not work properly or to prevent future problems. It is also
important to update drivers that patch or correct security problems. Updating device drivers
should be part of your preventive maintenance program to ensure that your drivers are
always current. If a driver update does not work properly, use the Roll Back Driver feature
to revert to the previously installed driver.

Firmware Updates
Manufacturers occasionally release new firmware updates to address issues that might not
be fixed with driver updates. Firmware updates are less common than driver updates. They
can increase the speed of certain types of hardware, enable new features, or increase the sta-
bility of a product. Follow the computer manufacturer’s instructions carefully when per-
forming a firmware update to avoid making the hardware unusable. Research the firmware
updates completely because it might not be possible to revert to the original firmware.
Checking for firmware updates should be part of your preventive maintenance program.

Operating System Updates
Microsoft releases updates to address security issues and other functionality problems. You
can install individual updates manually from the Microsoft website or automatically using
the Windows Automatic Update utility.

Downloads that contain multiple updates are known as service packs. A service pack usual-
ly contains all of the updates for an operating system. Installing a service pack is a good
way to bring your operating system up to date quickly. Set a restore point and back up criti-
cal data prior to installing a service pack. Add operating system updates to your preventive
maintenance program to ensure that your operating system has the latest functionality and
security fixes.

Security
Security is an important aspect of your preventive maintenance program. Install virus and
malware protection software and perform regular scans on your computer to help ensure
that your computer remains free of malicious software. Use the Windows Malicious
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Software Removal Tool to check a computer for specific, prevalent malicious software. If
an infection is found, the tool removes it. Each time a new version of the tool is available
from Microsoft, download it and scan your computer for new threats. This should be a stan-
dard item in your preventive maintenance program along with regular updates to your
antivirus and spyware removal tools.

Startup Programs
Some programs, such as antivirus scanners and spyware removal tools, do not automatically
start when the computer boots up. To ensure that these programs run each time the comput-
er is booted, add the program to the Startup folder of the Start menu. Many programs have
switches to allow the program to perform a specific action, start up without being displayed,
or go to the Windows tray. Check the documentation to determine if your programs allow
the use of special switches.

Schedule a Task
Some preventive maintenance consists of cleaning, inspecting, and doing minor repairs.
Some preventive maintenance uses application tools that are either already in the operating
system or can be loaded onto the user’s hard drive. Most preventive maintenance applica-
tions can be set to run automatically according to a schedule.

Windows has the following utilities that launch tasks when you schedule them:

n The DOS AT command launches tasks at a specified time using the CLI.

n Windows Task Scheduler launches tasks at a specified time using a GUI.

Information about the AT command is available at this path in Windows XP:

Start > Run, type cmd, and press Enter

Then type AT /? at the command line.

In Windows Vista, access the command line using the following path:

Start > Start Search, type cmd, and press Enter

Then type AT /? at the command line.

Access Windows Task Scheduler by following this path in Windows XP:

Start > All Programs > Accessories > System Tools > Scheduled Tasks

In Windows Vista, follow this path:

Start > All Programs > Accessories > System Tools > Task Scheduler
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Both of these tools allow you to run a command once at a specific time or schedule a com-
mand to run on selected days or times. Windows Task Scheduler, shown in Figure 5-32, is
easier to learn and use than the AT command, especially when it comes to recurring tasks
and deleting tasks already scheduled.

Figure 5-32 Windows Task Scheduler
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System Utilities
Several utilities included with DOS and Windows help maintain system integrity. Two sys-
tem utilities that are useful tools for preventive maintenance are

n ScanDisk or CHKDSK: ScanDisk (Windows 2000) and CHKDSK (Windows XP and
Vista) check the integrity of files and folders and scan the hard disk surface for physical
errors. Consider using ScanDisk or CHKDSK at least once a month and also whenever
a sudden loss of power causes the system to shut down.

n Defrag: As files increase in size, some data is written to the next available space on the
disk. In time, data becomes fragmented, or spread all over the hard drive. It takes time
to seek each section of the data. Defrag gathers the noncontiguous data into one place,
making files run faster.

You can access both of these utilities by using this path in Windows XP:

Start > All Programs > Accessories > System Tools > Disk Defragmenter

In Windows Vista, use this path:

Start > Computer > right-click Drive x > Properties > Tools

Automatic Updates
If every maintenance task had to be scheduled every time it was run, repairing computers
would be much harder than it is today. Fortunately, tools such as the Scheduled Task Wizard
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allow many functions to be automated. But how can you automate the update of software
that has not been written?

Operating systems and applications are constantly being updated for security purposes and
for added functionality. It is important that Microsoft and others provide an update service,
as shown in Figure 5-33. The update service can scan the system for needed updates and
then recommend what should be downloaded and installed. Enabling Automatic Updates
can download and install updates as soon as they are available, or it can download updates
as required and install them when the computer is next rebooted. The Microsoft Update
Wizard is available at this path in Windows XP:

Start > Control Panel > System > Automatic Updates

In Windows Vista, it is available at this path:

Start > Control Panel > Windows Update

Figure 5-33 Automatic Updates
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Most antivirus software contains its own update facility. It can update both its application
software and its database files automatically. This feature allows it to provide immediate
protection as new threats develop.

Restore Point
An update can sometimes cause serious problems. Perhaps an older program is in the sys-
tem that is not compatible with the current operating system. An automatic update might
install code that works for most users but does not work with your system.
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You can solve this problem by creating a restore point, which is an image of the computer
settings. If the computer crashes or an update causes system problems, the computer can
roll back to a previous configuration. You can use the Windows System Restore utility, as
shown in Figure 5-34, to create and revert to a restore point. Restore points are not the same
as backups. Restore points monitor a limited number of critical files. A backup normally
addresses all the files. 

A technician should always create a restore point before updating or replacing the operating
system. Restore points should also be created at the following times:

n When an application is installed

n When a driver is installed

Figure 5-34 Windows System Restore
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Note
A restore point backs up drivers, system files, and Registry settings but not application data.

To restore or create a restore point, use the following path:

Start > All Programs > Accessories > System Tools > System Restore

Backup Status and Configuration
Windows Vista has the Backup Status and Configuration tool for backing up photos, music,
email, and other types of user data. Backups can be set to run automatically at regular inter-
vals. Back up your data to a drive other than the drive that contains the operating system.
The Backup Status and Configuration tool is not used to back up system settings. Windows
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Vista Home Basic does not include the option to set automatic backups. To access the
Backup Status and Configuration tool, use the following path:

Start > All Programs > Accessories > System Tools > Backup Status and
Configuration

ERD and ASR
Windows 2000 offers the ability to create an emergency repair disk (ERD) that saves criti-
cal boot files and configuration information necessary to troubleshoot problems in
Windows. Windows XP offers the same features with the Automated System Recovery
(ASR) wizard. Although both ERD and ASR are powerful troubleshooting tools, they
should never replace a good backup.

A recovery disc contains the essential files used to repair the system after a serious issue,
such as a hard drive crash. The recovery disc can contain the original version of Windows,
hardware drivers, and application software. When the recovery disc is used, the computer is
restored to the original default configuration.

Lab 5.6.2: Restore Points in Windows XP

In this lab, you will create a restore point and return your computer back to that point in
time in Windows XP. Refer to the lab in IT Essentials: PC Hardware and Software Lab
Manual, Fourth Edition. You can perform this lab now or wait until the end of the chapter.

Optional Lab 5.6.2: Restore Points in Windows Vista

In this lab, you will create a restore point and return your computer back to that point in
time in Windows Vista. Refer to the lab in IT Essentials: PC Hardware and Software Lab
Manual, Fourth Edition. You can perform this lab now or wait until the end of the chapter.

Back Up the Hard Drive
Just as the system restore points allow the restoration of OS configuration files, backup
tools allow the recovery of data. You can use the Microsoft Backup Utility, shown in Figure
5-35, to perform backups as required. It is important to establish a backup strategy that
includes data recovery. The organization’s requirements will determine how often the data
must be backed up and the type of backup to perform.

172 IT Essentials: PC Hardware and Software Companion Guide

9781587132636_ch05.qxp  8/20/10  1:38 PM  Page 172

DRAFT



Figure 5-35 Microsoft Backup Utility
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It can take a long time to run a backup. If the backup strategy is followed carefully, it will
not be necessary to back up every file at every backup. It is only necessary to make copies
of the files that have changed since the last backup. For this reason, there are several differ-
ent types of backups.

Normal Backup
A normal backup is also called a full backup. During a normal backup, all selected files on
the disk are archived to the backup medium. These files are marked as having been archived
by clearing the archive bit. The archive bit flags files that have been modified and should be
backed up. 

Copy Backup
A copy backup copies all selected files. It does not mark the files as having been archived.

Differential Backup
A differential backup backs up all the files and folders that have been created or modified
since either the last normal backup or the last incremental backup (see the next section).
The differential backup does not mark the files as having been archived. Copies are made
from the same starting point until the next incremental or full backup is performed. Making
differential backups is important because only the last full and differential backups are
needed to restore all the data.
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Incremental Backup
An incremental backup procedure backs up all the files and folders that have been created
or modified since either the last normal or incremental backup. It marks the files as having
been archived by clearing the archive bit. This has the effect of advancing the starting point
of differential backups without having to re-archive the entire contents of the drive. If you
must perform a system restore, restore the last full backup first, then restore each incremen-
tal backup in order, and finally, restore the differential backups made since the last incre-
mental backup.

Daily Backup
Daily backups only back up the files that are modified on the day of the backup. Daily
backups do not modify the archive bit.

To access the daily backup utility on a Windows XP Professional system, use the following
path:

Start > All Programs > Accessories > System Tools > Backup

To access the daily backup utility in Windows Vista, use the following path:

Start > All Programs > Accessories > System Tools > Backup Status and
Configuration

Backup Media
Many types of backup media are available for computers:

n Tape drives are devices that are used for data backup on a network server drive. Tapes
drives are an inexpensive way to store a lot of data.

n The Digital Audio Tape (DAT) standard uses 4-mm digital audiotapes to store data in
the Digital Data Storage (DSS) format.

n Digital Linear Tape (DLT) technology offers high-capacity and relatively high-speed
tape backup capabilities.

n USB flash memory can hold hundreds of times the data that a floppy disk can hold.
USB flash memory devices are available in many capacities and offer better transfer
rates than tape devices.

n Optical media, such as CDs, DVDs, and Blu-ray discs, are plastic discs used to store
data. Many formats and capacities of optical media are available. A DVD holds much
more data than a CD, and a Blu-ray disc holds much more data than a DVD.
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n External hard disk drives (HDD) are hard drives that are connected to your computer
using a USB, FireWire, or external Serial ATA (eSATA) connection. External HDDs
can hold very large amounts of data and can transfer data very quickly.

n Network HDDs are frequently used as a backup media. There is a wide variety of net-
work storage, ranging from simple network-attached storage (NAS) to highly complex
and secure storage area networks (SAN). 

Lab 5.6.3: Registry Backup and Recovery in Windows XP

In this lab, you will back up a computer Registry and perform a recovery of a computer
Registry. Refer to the lab in IT Essentials: PC Hardware and Software Lab Manual, Fourth
Edition. You can perform this lab now or wait until the end of the chapter.

Troubleshoot Operating Systems
Most operating systems contain utilities to assist in the troubleshooting process. These utili-
ties help technicians determine why the computer crashes or does not boot properly. The
utilities also help identify the problem and how to resolve it.

Follow the steps outlined in this section to accurately identify, repair, and document the
problem. 

After completing this section, you will meet these objectives:

n Review the troubleshooting process.

n Identify common problems and solutions.

Review the Troubleshooting Process
Operating system problems can result from a combination of hardware, application, and
configuration issues. Computer technicians must be able to analyze the problem and deter-
mine the cause of the error to repair the operating system. This process is called trou-
bleshooting.

Step 1: Identify the Problem
The first step in the troubleshooting process is to gather data from the customer. This can be
done by asking the customer some open-ended and closed-ended questions. Table 5-5 pro-
vides a list of open-ended and closed-ended questions to ask the customer about operating
system problems. (This list is not comprehensive.) 
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Table 5-5 Operating System Problems: Open-Ended and Closed-Ended Questions 
to Ask

Open-Ended Questions Closed-Ended Questions

What problems are you experiencing Has anyone else used your computer 
with your computer or network? recently?

What software has been installed Does the computer boot up successfully?
on your computer recently?

What were you doing when the Have you changed your password recently?
problem was identified?

What operating system do you Have you received any error messages on
have installed on your computer? your computer?

What updates or patches have Are you currently logged in to the network?
been installed on your computer?

Step 2: Establish a Theory of Probable Causes 
After you have talked to the customer, you should verify the obvious issues. Some issues
for operating systems include

n Incorrect settings are in the BIOS.

n The Caps Lock key is set to ON.

n Nonbootable media is in the floppy drive during computer bootup.

n The password has changed.

n The monitor does not have power. 

n Monitor settings are incorrect.

Step 3: Determine an Exact Cause
After the obvious issues have been verified, try some quick solutions. A list of possible
quick solutions for operating systems include

n Press F8 during bootup to use the Last Known Good Configuration settings.

n Press F8 to enter Safe Mode to troubleshoot video problems.

n Uninstall an application that was recently added by using the Add or Remove Programs
utility in the Control Panel.

n Roll back the system using a system restore point.

n Examine Device Manager for device conflicts.
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n Run Cleanmgr to remove temporary files.

n Run ScanDisk to repair problems with the hard drive.

n Run Defrag to speed up the hard drive.

n Reboot the computer.

n Log in as a different user.

Step 4: Implement a Solution
If no solution is achieved in the previous step, further research is needed to implement the
solution. Some different ways to gather information about the problem from the computer
include the following:

n Helpdesk repair logs

n Other technicians

n Manufacture FAQs

n Technical websites

n News groups

n Computer manuals

n Device manuals

n Online forums

n Internet search

Step 5: Verify Solution and Full System Functionality
To ensure full system functionality, do the following tasks:

n Shut down the computer and restart it.

n Check event logs to make sure there are no new warnings or errors.

n Check Device Manager to see whether there are no warnings or errors.

n Run DxDiag to make sure DirectX is running correctly.

n Make sure the Internet can be accessed.

n Rerun system file checker to ensure that all files are correct.

n Rerun scandisk to make sure no problems remain on the hard drive.

n Check Task Manager to ensure that no programs are running incorrectly.

n Rerun any third-party diagnostic tools.
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Step 6: Document Findings
After you have solved the problem, you will close with the customer. A list of the steps
required to complete this task include the following:

n Discuss the solution implemented with the customer.

n Have the customer verify that the problem has been solved.

n Provide the customer with all paperwork.

n Document the steps taken to solve the problem in the work order and the technician’s
journal.

n Document any components used in the repair.

n Document the time spent to resolve the problem.

n Keep a copy of all paperwork generated during the troubleshooting process. 

Identify Common Problems and Solutions
Operating system problems can be attributed to hardware, application, or configuration
issues, or to some combination of the three. You will resolve some types of operating sys-
tem problems more often than others. Table 5-6 is a chart of common operating system
problems and solutions. 

Table 5-6 Common Problems and Solutions

Identify the Problem Probable Causes Possible Solutions

The computer locks up The computer is Reboot the computer.
and/or displays a blue overheating. Check the event log for 
screen. alerts and address them.

Some of the operating 
system files may be Install or roll back 
corrupted. updated drivers.

The power supply, RAM, Test the power supply,
hard drive, or  RAM, hard drive or 
motherboard may be motherboard with third-party 
defective. diagnostic software and 

replace as necessary.
The BIOS settings may 
be incorrect. Run the system file checker

to replace corrupt operating 
An incorrect driver has system files. 
been installed.
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Identify the Problem Probable Causes Possible Solutions

Examine and adjust the 
BIOS settings. 

Check the fan connections 
and ensure fans are 
operating properly.

The keyboard or mouse The computer has the Check the status light
does not respond. wrong, incorrectly  indicators on the keyboard.

installed, not current, or 
incompatible driver. Reboot the computer.

The input/output software Install or roll back updated 
in not installed properly. drivers.

The operating system is Reinstall the input/output 
not up to date. device software.

The cable has been Update the operating system 
damaged. from the Windows Update 

website.
The device is defective.

The computer has a virus. Replace the device.

Run a virus scan and obtain 
updates if necessary.

The application does not install. The downloaded Reboot the computer.
application installer 
contains a virus and Close applications before 
has been prevented from installing a new program.
installing by virus protection 
software. Scan the downloaded 
The installation disk or application installer of 
file is corrupt. viruses.

The application is not 
compatible with the Obtain a new installation 
operating system disk or delete the file and 
There are too many download the installation file 
programs running and again. 
not enough memory 
remaining to install the Run the installation 
application application in compatibility 

mode.

continues
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Table 5-6 Common Problems and Solutions continued

Identify the Problem Probable Causes Possible Solutions

The operating system There is a non-bootable Remove all non-bootable 
will not start. disk in the boot drive. media from the drives.

Dome of the operating Reboot the computer.
system files may be 
corrupted.

The Master Boot Record Use the Last Known Good 
is corrupt. Configuration option to start

the operating system. 

The power supply, RAM, Boot the computer in 
hard drive, or motherboard Safe Mode.
may be defective. 

Use Recovery Console to fix
the Master Boot Record.

Disconnect any newly 
connected devices.

Replace the power supply,
RAM, hard drive, or mother-
board with one that works.

Perform a Repair Installation
on the operating system.

A document will The printer spooler has Clear the print spooler of 
not print even though become overloaded and any print jobs.
the printer is correctly stopped responding.
installed and configured The printer software is Restart the print spooler 
and the application is outdated. service.
functioning properly.

The operating system has Reboot the computer.
been automatically updated 
with a bad driver. Install or roll back 

updated drivers.

Update the printer software.
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Lab 5.7.2: Managing Device Drivers with Device Manager in Windows XP

In this lab, you will manage device drivers with Device Manager in Windows XP. Refer to
the lab in IT Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You can
perform this lab now or wait until the end of the chapter.

Optional Lab 5.7.2: Managing Device Drivers with Device Manager in Windows Vista

In this lab, you will manage device drivers with Device Manager in Windows Vista. Refer
to the lab in IT Essentials: PC Hardware and Software Lab Manual, Fourth Edition. You
can perform this lab now or wait until the end of the chapter.
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Summary
This chapter introduced computer operating systems. As a technician, you should be skilled
at installing, configuring, and troubleshooting an operating system. The following concepts
from this chapter are important to remember:

n There are several different operating systems available, and you must consider the cus-
tomer’s needs and environment when choosing an operating system.

n The main steps in setting up a customer’s computer include preparing the hard drive,
installing an operating system, creating user accounts, and configuring installation
options.

n A GUI shows icons of all files, folders, and applications on the computer. A pointing
device, such as a mouse, is used to navigate a GUI desktop.

n You should establish a backup strategy that allows the recovery of data. Normal, copy,
differential, incremental, and daily backups are all optional backup tools available in
Windows operating systems.

n Preventive maintenance techniques help to ensure optimal operation of the operating
system.

n Some of the tools available for troubleshooting an operating system problem include
the Windows Advanced Startup Options menu, event logs, Device Manager, and sys-
tem files.

Summary of Exercises
This is a summary of the Labs and Worksheets associated with this chapter.

Labs
The following labs cover material from this chapter. Refer to the labs in IT Essentials: PC
Hardware and Software Lab Manual, Fourth Edition.

Lab 5.4.2: Install Windows XP

Optional Lab 5.4.2: Install Windows Vista

Lab 5.4.5: Create Accounts and Check for Updates in Windows XP

Optional Lab 5.4.5: Create Accounts and Check for Updates in Windows Vista

Lab 5.4.8: Managing System Files with Built-in Utilities in Windows XP

Optional Lab 5.4.8: Managing System Files with Built-in Utilities in Windows Vista
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Lab 5.5.1: Run Commands in Windows XP

Optional Lab 5.5.1: Run Commands in Windows Vista

Lab 5.5.3: Managing Administrative Settings and Snap-ins in Windows XP

Optional Lab 5.5.3: Managing Administrative Settings and Snap-ins in Windows Vista

Lab 5.5.4: Install Third-Party Software in Windows XP 

Optional Lab 5.5.4: Install Third-Party Software in Windows Vista 

Lab 5.6.2: Restore Points in Windows XP

Optional Lab 5.6.2: Restore Points in Windows Vista 

Lab 5.6.3: Registry Backup and Recovery in Windows XP

Lab 5.7.2: Managing Device Drivers with Device Manager in Windows XP

Optional Lab 5.7.2: Managing Device Drivers with Device Manager in Windows Vista

Worksheets
The following worksheets cover material from this chapter. Refer to the labs in IT
Essentials: PC Hardware and Software Lab Manual, Fourth Edition:

Worksheet 5.2.2: NOS Certifications and Jobs

Worksheet 5.3.2: Upgrade Hardware Components

Worksheet 5.4.9: Answer NTFS and FAT32 Questions

Check Your Understanding
You can find the answers to these questions in the appendix, “Answers to Check Your
Understanding Questions.”

1. Which open-source operating system is available on multiple hardware platforms?

A. Linux

B. Mac OS X

C. Windows 2000

D. Windows XP
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2. Which Registry file contains information about the hardware and software in the com-
puter system?

A. HKEY_CLASSES_ROOT

B. HKEY_CURRENT_USER

C. HKEY_LOCAL_MACHINE

D. HKEY_USERS

3. How can the command line be accessed in Windows XP?

A. Start > Run > Prompt

B. Start > Run > cmd

C. Start > Control Panel > Prompt

D. Start > All programs > Accessories > Terminal

E. Start > Run > Terminal

4. Which file system is recommended for Windows XP for large file support and
enhanced security?

A. DirectX 

B. DOS 

C. FAT32 

D. HPFS 

E. NTFS

5. What does a red “X” on a device mean in the Device Manager?

A. The device driver is unsigned.

B. The device driver is missing or corrupt.

C. The device has been disabled.

D. The device is functioning properly.

6. What should be done before upgrading from Windows 2000 to Windows XP?

A. Back up all the data files.

B. Update all the device drivers. 

C. Detach all the peripheral devices. 

D. Download a legitimate Windows XP authentication key.
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7. Which key or key sequence will enable a user to start Windows XP in Safe Mode?

A. Alt-B 

B. Alt-X 

C. Alt-Z 

D. F1 

E. F8 

F. The Windows key

8. What is a good example of an open-ended question that a technician can ask the user to
learn more about conditions before the failure?

A. What software has been installed recently on the computer?

B. Does the computer boot into the operating system?

C. Are there any beeps when the computer boots?

D. Has anybody else used the computer recently?

E. How many users were logged on to the network when the failure occurred?

9. What is a common cause of the error message “Invalid system disk”?

A. The Delete key was pressed during the system boot.

B. There is a nonbootable floppy disk or CD in the drive.

C. There is no floppy disk or CD in the drive.

D. The BIOS has been changed to boot from the hard drive first.
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